Copyright Notice
Copyright © 2004, Palisade Corporation.

Trademark Acknowledgments
Microsoft, Excel and Windows are registered trademarks of Microsoft, Inc.
IBM is a registered trademark of International Business Machines, Inc.
Palisade, TopRank, BestFit and RISKview are registered trademarks of Palisade Corporation.
RISK is a trademark of Parker Brothers, Division of Tonka Corporation and is used under license.
Welcome

Welcome to RISKview, the distribution viewing companion for any Windows software. RISKview helps you select a probability distribution graphically by previewing different distributions and parameters before introducing them to your model. RISKview also includes the Distribution Artist, a tool which extracts data points from a probability curve that you draw.

Why You Need RISKview

RISKview takes the guess-work out of selecting a distribution by allowing you to visually assess the curve. Not sure how changing a parameter affects the shape of a curve? RISKview shows you. Want to know the vital statistics of the distribution before running a simulation? RISKview tells you. Do you have a mental image of what the curve should look like? RISKview translates your drawing to a probability distribution function.

RISKview is great if you’re just learning about probability distributions, but advanced users will find it useful too. We have all experienced times when we know what we want a distribution to look like, but we don’t know how to translate that mental image to a distribution function. RISKview allows you to visualize a distribution function before introducing it to your simulation model.
List of Features

*RISKview and @RISK*

Although RISKview can run on its own, it is most useful when it is integrated in @RISK, the risk analysis and simulation program from Palisade Corporation. Every copy of @RISK for Excel contains a fully integrated copy of RISKview. BestFit, Palisade's distribution fitting software, also contains a fully integrated copy of RISKview. This allows you to preview distributions while you are fitting distributions to data.

**Distribution Functions**

RISKview previews over 30 probability distribution functions, all available in @RISK. And, RISKview tells you the vital statistics for each function, including mean, mode, variance, skewness and kurtosis.

The probability distributions provided by RISKview allow the specification of nearly any type of uncertainty. Available distributions include:

<table>
<thead>
<tr>
<th>Beta</th>
<th>Gamma</th>
<th>Normal</th>
</tr>
</thead>
<tbody>
<tr>
<td>BetaGeneral</td>
<td>General</td>
<td>Pareto</td>
</tr>
<tr>
<td>Beta-Subjective</td>
<td>Geometric</td>
<td>Pareto2</td>
</tr>
<tr>
<td>Binomial</td>
<td>Histogram</td>
<td>Pearson V</td>
</tr>
<tr>
<td>Chi-Square</td>
<td>Hypergeometric</td>
<td>Pearson VI</td>
</tr>
<tr>
<td>Cumulative</td>
<td>Inverse Gaussian</td>
<td>PERT</td>
</tr>
<tr>
<td>Discrete</td>
<td>IntUniform</td>
<td>Poisson</td>
</tr>
<tr>
<td>Discrete Uniform</td>
<td>Logistic</td>
<td>Rayleigh</td>
</tr>
<tr>
<td>Error Function</td>
<td>Log-Logistic</td>
<td>Student's t</td>
</tr>
<tr>
<td>Erlang</td>
<td>Lognormal</td>
<td>Triangular</td>
</tr>
<tr>
<td>Exponential</td>
<td>Lognormal2</td>
<td>Trigen</td>
</tr>
<tr>
<td>Extreme Value</td>
<td>Negative Binomial</td>
<td>Uniform</td>
</tr>
</tbody>
</table>

**Distribution Artist**

Do you want to create your own probability distribution? Draw your own curve using the Distribution Artist and let RISKview create a GENERAL distribution function from the drawing. A smoothing algorithm ensures that shaky hands don’t affect the final distribution.
Table of Contents

Welcome ......................................................... i
Why You Need RISKview ........................................... i

Chapter 1: Getting Started ................................. 1
Introduction .......................................................... 3
Installation Instructions ........................................... 7

Chapter 2: An Overview of RISKview ................. 11
Introduction .......................................................... 13
What is a Probability Distribution Function? .......... 15
Using RISKview ..................................................... 17

Chapter 3: RISKview Reference Guide ................. 27
Introduction .......................................................... 29
Reference: RISKview Icons ................................. 31
Reference: RISKview Commands ....................... 35
File Menu ............................................................ 37
Edit Menu ............................................................ 39
Insert Menu .......................................................... 41
Graph Menu .......................................................... 45
Artist Menu .......................................................... 53
Chapter 1: Getting Started

Introduction ............................................................................................................. 3
Checking Your Package .................................................................................. 3
About This Version ........................................................................................... 3
Working with your Operating Environment .................................................. 4
If You Need Help ............................................................................................... 4
RISKview System Requirements ...................................................................... 6
Installation Instructions .................................................................................... 7
General Installation Instructions ....................................................................... 7
The DecisionTools Suite .................................................................................. 8
Setting Up the RISKview Icons or Shortcuts .................................................. 9
Introduction

This introduction describes the contents of your RISKview package and shows you how to install RISKview.

Checking Your Package

Your RISKview package should contain:

The RISKview CD-ROM including:

- RISKview Program
- The RISKview User’s Guide (this book) in PDF format with:
  - Getting Started
  - Overview to RISKview
  - RISKview Reference Guide
  - Technical Appendices

The RISKview Licensing Agreement

A complete listing of all files contained on the RISKview CD is contained in the file INSTALL.LOG found in the Program Files\Palisade\RISKVIEW45 directory on your hard disk.

If your package is not complete, please call your RISKview dealer or supplier or contact Palisade Corporation directly at (607) 277-8000. If you want to install RISKview from diskettes, please contact Palisade Corporation.

About This Version

This version of RISKview can be installed as a 32-bit program for Windows 98 or higher.
Working with your Operating Environment

This User’s Guide assumes that you have a general knowledge of the Windows operating system. In particular:

- You are familiar with your computer and using the mouse.
- You are familiar with terms such as icons, click, double-click, menu, window, command and object.
- You understand basic concepts such as directory structures and file naming.

If You Need Help

Technical support is provided free of charge for all registered users of BestFit with a current maintenance plan, or is available on a per incident charge. To ensure that you are a registered user of RISKview, please register online at www.palisade.com/html/register.html.

If you contact us by telephone, please have your serial number and User’s Guide ready. We can offer better technical support if you are in front of your computer and ready to work.

Before Calling

Before contacting technical support, please review the following checklist:

- Have you referred to the on-line help?
- Have you checked this User’s Guide and reviewed the on-line multimedia tutorial?
- Have you read the README.WRI file? It contains current information on RISKview that may not be included in the manual.
- Can you duplicate the problem consistently? Can you duplicate the problem on a different computer or with a different model?
- Have you looked at our site on the World Wide Web? It can be found at http://www.palisade.com. Our Web site also contains the latest FAQ (a searchable database of tech support questions and answers) and RISKview patches in our Technical Support section. We recommend visiting our Web site regularly for all the latest information on RISKview and other Palisade software.
Palisade Corporation welcomes your questions, comments or suggestions regarding RISKview. Contact our technical support staff using any of the following methods:

- E-mail us at tech-support@palisade.com.
- Telephone us at (607) 277-8000 any weekday from 9:00 AM to 5:00 PM, EST. Press 2 on a touch-tone phone to reach technical support.
- Fax us at (607) 277-8001.
- Mail us a letter at:
  
  Technical Support  
  Palisade Corporation  
  31 Decker Road  
  Newfield, NY 14867 USA

If you want to contact Palisade Europe:

- E-mail us at tech-support@palisade-europe.com.
- Telephone us at +44 (0)207 426 9950 (UK).
- Fax us at +44 (0)207 375 1229 (UK).
- Mail us a letter at:
  
  Palisade Europe  
  Technical Support  
  The Blue House, Unit 1  
  30 Calvin Street  
  London E1 6NW UK

Regardless of how you contact us, please include the product name, exact version and serial number. The exact version can be found by by selecting the Help About command on the RISKview menu.
Telephone support is not available with the student version of RISKview. If you need help, we recommend the following alternatives:

- Consult with your professor or teaching assistant.
- Log-on to our site on the World Wide Web for answers to frequently asked questions.
- Contact our technical support department via e-mail or fax.

**RISKview System Requirements**

System requirements for RISKview depend on the version of RISKview in use. These requirements include:

**RISKview for Windows**

- Pentium PC or faster with a hard disk.
- Microsoft Windows 98 or higher or Windows NT 4.0 or higher.
- 32 MB installed memory.
Installation Instructions

General Installation Instructions

The Setup program copies the RISKview system files into a directory you specify on your hard disk. Setup and RISKview require Microsoft Windows to run, so be sure to start Windows before running these programs.

To run the Setup program in Windows 98 or higher:
1) Insert the RISKview CD-ROM in your CD-ROM drive
2) Click the Start button, click Settings and then click Control Panel
3) Double-click the Add/Remove Programs icon
4) On the Install/Uninstall tab, click the Install button
5) Follow the Setup instructions on the screen

If you encounter problems while installing RISKview, verify that there is adequate space on the drive to which you're trying to install. After you've freed up adequate space, try rerunning the installation.

Within 30 days of installing RISKview you need to authorize your copy of RISKview.

Authorization can be done over the Internet by clicking the Authorize Now button and following the prompts on the screen. Alternatively, you can contact Palisade or Palisade Europe during normal business hours and authorize your copy of RISKview over the phone.

An authorized copy of RISKview is licensed for use on a single computer only. If you wish to move your copy of RISKview to a different computer, please contact Palisade for instructions.
Setup creates the file INSTALL.LOG in your RISKview directory. This file lists the names and locations of all installed files. If you wish to remove RISKview from your computer when running Windows 98 or higher or Windows NT 4 or higher, use the Control Panel's Add/Remove Programs utility and select the entry for RISKview.

The DecisionTools Suite

RISKview is a member of the DecisionTools Suite, a set of products for risk and decision analysis described in Appendix D: Using RISKview With Other DecisionTools. The default installation procedure of RISKview puts RISKview in a subdirectory of a main “Program Files\Palisade” directory. This is quite similar to how Excel is often installed into a subdirectory of a “Microsoft Office” directory.

One subdirectory of the Program Files\Palisade directory will be the RISKview directory (by default called RISKVIEW45). This directory contains the RISKview program file (RISKVIEW.EXE) plus example models and other files necessary for RISKview to run. Another subdirectory of Program Files\Palisade is the SYSTEM directory which contains files which are needed by every program in the DecisionTools Suite, including common help files and program libraries.
Setting Up the RISKview Icons or Shortcuts

In Windows, setup automatically creates a RISKview command in the Programs menu of the Taskbar. However, if problems are encountered during Setup, or if you wish to do this manually another time, follow the following directions.

1) Click the Start button, and then point to Settings.
2) Click Taskbar, and then click the Start Menu Programs tab.
3) Click Add, and then click Browse.
4) Locate the file RISKVIEW.EXE and double click it.
5) Click Next, and then double-click the menu on which you want the program to appear.
6) Type the name “RISKview”, and then click Finish.
Chapter 2: An Overview of RISKview

Introduction.....................................................................................................................13

What is a Probability Distribution Function?.........................................................15
Types of Distribution Functions..................................................................................15
Using RISKview ............................................................................................................17
  Starting RISKview ....................................................................................................17
  Distribution Palette ................................................................................................18
  Drawing a Curve .......................................................................................................20
  Creating a Distribution Function .............................................................................22
  Getting the Best Fitting Distribution ......................................................................23
  Graphs and Statistics for Fitted Distributions.......................................................24
  Using the Results of a Fit........................................................................................26
Introduction

RISKview is a distribution viewing companion to any Windows program. It helps you select a probability distribution by previewing different distributions and parameters before introducing them to your model.

This overview contains two sections. The first, What is a Probability Distribution Function?, talks about the different types of distribution functions and how they can be used to describe real-life situations. The second section, Using RISKview, gives a brief tour of RISKview and its features. Please refer to the next chapter, The RISKview Reference Guide, if you need more detailed information on RISKview’s commands and options.
What is a Probability Distribution Function?

A probability distribution is a set of probabilities associated with all possible outcomes of an uncertain event. Each probability distribution function has measured statistical and probabilistic properties, which depend directly on the parameters of the function.

Types of Distribution Functions

A probability distribution is continuous when any value between the minimum and maximum is possible (has finite probability). For example, an uncertainty function describing the possible annual rainfall in Ithaca, New York next year would be a continuous function since any value between 0 and some upper limit is possible.

A discrete probability distribution has only a finite number of possible values between the maximum and minimum. For example, an uncertainty function describing the outcome of a coin toss is discrete since only two values are possible: heads or tails.

RISKview offers both discrete (BINOMIAL GEOMET, etc.) and continuous (BETA, NORMAL, etc.) functions.

An empirical distribution uses observed data to specify a distribution directly, while a theoretical distribution uses a pre-defined distribution formula to represent a large set of data with a small set of parameters.

Most of RISKview's distribution functions are theoretical, but you can input empirical distributions using functions like GENERAL or CUMUL. Typically, it is preferable to use a theoretical distribution because it generates a smooth, consistent data set.
An empirical distribution may be "fitted" to a theoretical distribution using a distribution fitting method. In RISKview, the best theoretical distribution corresponding to an empirical distribution drawn in the Distribution Artist can be found.

For each theoretical distribution, RISKview tries to find parameters that cause the function's statistical properties to match those of the empirical distribution.

Any probability distribution may be expressed in cumulative form. A cumulative curve is typically scaled from 0 to 1 on the Y-axis, with Y-axis values representing the cumulative probability up to the corresponding X-axis value.

In the cumulative curve above, the 0.5 cumulative value is the point of 50% cumulative probability (0.5 = 50%). Fifty percent of the values in the distribution fall below this median value and fifty percent are above. The 0.0 cumulative value is the minimum value (0% of the values fall below this point) and the 1.0 cumulative value is the maximum value (100% of the values fall below this point).
Using RISKview

This section gives a brief overview of the features of RISKview. For more detailed information on each action and command, please refer to The RISKview Reference Guide in the following chapter.

Starting RISKview

The Setup program creates a Start Menu entry for RISKview in a group titled Palisade DecisionTools. Selecting this entry starts RISKview.
Distribution Palette

The main RISKview window displays a graph of any distribution function with any parameters. To display a new graph, just change the function shown in the Dist... drop down list or click the Dist... button to display the Distribution Palette (selecting from the list of available distributions), or change the values of any of the distribution parameters.

On the right side of the distribution window, statistics for the graphed distribution are displayed. These values update each time the graph is changed.

Using Delimiters

Delimiters (marked with inverted triangles) allow setting of target probabilities and x-axis scaling using the mouse. Cumulative probabilities can be set directly on a distribution graph using the displayed probability delimiters. Dragging probability delimiters changes left and right x and p values shown in the probability bar below the graph and in the statistics grid. Dragging the delimiters at either end of the x-axis rescales the x-axis.
Right-clicking in the distribution window and selecting Add Overlay allows you to switch between specifying a distribution for the primary or overlay curve. This allows you to compare how two distributions differ graphically. Moving delimiters across an overlaid distribution graph displays target probabilities for both the primary and overlay curve in the statistics to the right of the graph. This allows you to easily compare the probabilities associated with different target values for the two different distributions.
Drawing a Curve

Clicking the Insert Artist Window icon displays a window in which you can draw your own curve to represent the probabilities of different values occurring. This “hand-drawn” curve can then be transformed into a probability distribution that you can use as needed.

To draw in the Distribution Artist window, you can clear the initial "pre-drawn" curve by clicking the Clear Curve icon (the first icon on the Artist toolbar) or selecting Clear Curve from the right-click pop-up menu. Then, enter the minimum and maximum values for your curve. To draw, simply move the mouse to the point where you wish to start the distribution and hold down the left mouse button. Drag the mouse to the right (while keeping the left mouse button down) until you have finished drawing the curve.
Clicking the **Smooth Curve** icon (the second from the left on the Artist toolbar) smoothes out the jagged points on the drawn curve. Repeatedly clicking the Smooth Curve icon smooths a drawn curve more and more. For example, the drawn curve shown here:

Results in the following graph after smoothing:
After drawing a curve, you may wish to "drag" one of the data points to a new location. Simply click the left mouse button on the data point and, while holding down the button, drag the point to a new location. When you lift the button, the curve is re-drawn automatically to include the new data point. The Distribution Artist connects the dragged point to its adjacent point with either a curved or straight line. Check the option you prefer in the window.

Creating a Distribution Function

Once you are satisfied with the shape of your curve, you can convert it to a General distribution by clicking the Create Distribution icon (the third icon on the Artist toolbar) or selecting the Create Distribution command from the right-click pop-up menu. A General distribution is simply a set of X-Y points that describe your curve. This curve represents a probability distribution that can be sampled in @RISK.
Getting the Best Fitting Distribution

Your drawn curve can also be converted to a theoretical function by clicking the **Fit Curve** icon (the fourth icon on the Artist toolbar) or selecting the **Fit Curve** command from the right-click popup menu. After fitting, a **Fit Results** window displays the results of the fitting of your curve against 27 available probability distribution types.

By clicking on the possible fitted distributions listed, you can see how each distribution compares with your original curve.

RISKview uses the least squares method to fit your drawn curve to a theoretical distribution. The best fitting distribution is the one with the smallest root-mean square error (RMSErr). The RMSErr between set of n curve points (Xi, Yi) and a theoretical distribution function f(x) with one parameter \( \alpha \) is:

\[
RMSErr = \sqrt{\frac{1}{n} \sum_{i=1}^{n} (f(x_i, \alpha) - y_i)^2}
\]

The value of \( \alpha \) that minimizes this value is called the least squares fit. In a sense, this value minimizes the “distance” between the theoretical curve and the data. The formula above is easily generalized to more than one parameter.

This method is used to calculate the best distribution for both density and cumulative curve data which can be entered in a Distribution Artist window.
Graphs and Statistics for Fitted Distributions

RISKview provides two types of graphs to help you visually assess the quality of your fits.

A comparison graph superimposes the input data and fitted distribution on the same graph, allowing you to visually compare them either as density or cumulative curves. This graph allows you to determine if the fitted distribution matches the input data in specific areas. For example, it may be important to have a good match around the mean or in the tails.
**Difference Graphs**

A difference graph displays the absolute error between the fitted distribution and the input data.

**Statistics and Targets**

RISKview reports basic statistics (mean, variance, mode, etc.) for each fitted distribution, which can easily be compared to the same statistics for the input data.

RISKview allows you to compare percentiles and target values between distributions and the input data. For example, perhaps the 5th and 95th percentiles values are important to you. This can be done by moving the delimiters which allow you to visually set two different targets or percentiles.
Using the Results of a Fit

Once you have analyzed the results of your fit, you may wish to export the results to another program. Of course, you can always copy and paste any RISKview graph or report into Excel or another Windows application via the clipboard. In addition, using the **Graph In Excel** command, RISKview allows you to create a copy of the current RISKview graph in Excel’s native chart format. You will need to have Excel running to do this.
Chapter 3: **RISKview Reference Guide**

Introduction ........................................................................................................... 29

Reference: RISKview Icons .............................................................................. 31

RISKview Toolbar ............................................................................................. 32

Reference: RISKview Commands ................................................................. 35

File Menu ............................................................................................................. 37
  New Command ............................................................................................... 37
  Open Command ............................................................................................ 37
  Save Command, Save As Command ............................................................ 38
  Print Command ............................................................................................ 38
  Exit Command ............................................................................................ 38

Edit Menu........................................................................................................... 39
  Cut Command ............................................................................................... 39
  Copy Command ............................................................................................ 39
  Paste Command ........................................................................................... 39

Insert Menu ....................................................................................................... 41
  Artist Window Command ............................................................................ 41
  Distribution Window Command ................................................................. 42

Graph Menu ........................................................................................................ 45
  Graph Format Command ............................................................................. 45
  Type Tab – Graph Format Command .......................................................... 45
  Scaling Tab – Graph Format Command ....................................................... 47
  Style Tab – Graph Format Command .......................................................... 49
  Titles Tab – Format Command ..................................................................... 50
  Delimiters Tab – Graph Format Command .................................................. 51
  Graph in Excel Command ............................................................................ 52
  Delimiter Defaults Command ...................................................................... 52

Artist Menu.......................................................................................................... 53
  Artist Window ............................................................................................... 53
  Clear Curve Command .................................................................................. 54
Introduction

This chapter describes the icons, commands, probability distribution functions and macros used to set up and execute a risk analysis using RISKview. The RISKview Reference Guide chapter is divided into two sections:

1) Reference: RISKview Icons
2) Reference: RISKview Commands
Reference: RISKview Icons

RISKview icons are used to quickly and easily perform tasks necessary to fit probability distributions to data. RISKview icons appear in the RISKview window. This section briefly describes each icon, outlining the functions they perform and the menu command equivalents associated with them.

A second toolbar titled DecisionTools is also available when @RISK for Excel is installed. This toolbar contains icons which can be used to run RISKview or any of the other programs in the DecisionTools suite (if these programs are installed on your system). For more information on the DecisionTools suite, see Appendix A: Using RISKview With Other DecisionTools.
RISKview Toolbar

The following icons are shown on the RISKview toolbar in the RISKview Window.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function Performed and Command Equivalent</th>
</tr>
</thead>
</table>
| ![Density Graph Icon] | Display current graph as a density graph  
Command equivalent: Graph menu Format Graph command  
Graph Type - Density option |
| ![Cumulative Ascending Line Graph Icon] | Display current graph as a cumulative ascending line graph  
Command equivalent: Graph menu Format Graph command  
Graph Type - Cumulative Ascending option |
| ![Cumulative Ascending Area Graph Icon] | Display current graph as a cumulative ascending area graph  
Command equivalent: Graph menu Format Graph command  
Graph Type - Cumulative Ascending option |
| ![Graph Format Options Icon] | Display graph format options  
Command equivalent: Graph menu Format Graph command |
| ![Excel Format Graph Icon] | Generate current graph as an Excel format graph  
Command equivalent: Graph menu Graph in Excel command |
| ![Insert Artist Window Icon] | Insert Artist Window  
Command equivalent: Insert menu Artist Window command |
| ![Insert Distribution Window Icon] | Insert Distribution Window  
Command equivalent: Insert menu Distribution Window command |
| ![Clear Curve Icon] | Clear current curve in Distribution Artist window  
Command equivalent: Artist menu Clear Curve command |
| ![Smooth Curve Icon] | Smooth current curve in Distribution Artist window  
Command equivalent: Artist menu Smooth Curve command |
<table>
<thead>
<tr>
<th>Task</th>
<th>Command equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create distribution from current curve in Distribution Artist window</td>
<td>Artist menu Create Distribution command</td>
</tr>
<tr>
<td>Find best fitting distribution for the current curve in Distribution Artist window</td>
<td>Artist menu Fit Curve command</td>
</tr>
<tr>
<td>Copy current curve or points from the Distribution Artist window</td>
<td>Artist menu Copy command</td>
</tr>
</tbody>
</table>
Reference: RISKview Commands
File Menu

New Command

Opens a new RISKview project.

When the File New command is selected, a blank window is displayed and all graphs are closed. The Save As dialog box appears if you haven’t saved the current project.

Open Command

Opens a saved RISKview project

The File Open command opens a previously saved RISKview project (.RVP file) including all drawn curves and distribution graphs.

Open Icon

Reference: RISKview Commands
Save Command, Save As Command

**Saves the current RISKview project**

The File menu Save and Save As commands save the current RISKview graphs in a .RVP file.

![Save Icon](Image)

**Print Command**

**Prints the current graph**

The Print command prints the active RISKview graph.

**Exit Command**

**Exits RISKview**

The File menu Exit command shuts down RISKview. You will have an opportunity to save the current RISKview project prior to exiting.
Edit Menu

Cut Command

Cuts the current selection

The Edit menu Cut command cuts the current selection. This data can be pasted from the Clipboard to other applications.

Copy Command

Copies RISKview reports and graphs to the Windows Clipboard

The Edit menu Copy command is used to transfer RISKview reports and graphs to the Clipboard so they can be pasted into your spreadsheet or word processor. The data to be copied is determined by the current active window and selection in RISKview. The active window is the one with its title bar highlighted.

RISKview graphs are copied to the clipboard as Windows metafiles. When placed in your spreadsheet they may be resized and annotated.

Paste Command

Pastes the current contents of the Clipboard into an RISKview statistics report

The Edit menu Paste command is used to transfer the Clipboard contents into the current selection.
Insert Menu

Artist Window Command

Inserts an Artist Window in the RISKview window

The Insert menu Artist Window command (or clicking the Insert Artist Window icon) inserts an artist window in the RISKview window. An artist window allows a free-form curve to be drawn, which can then be used to define a probability distribution.

To learn about the commands used to draw curves in the Artist window, see Artist Menu Commands in this Reference section.
Distribution Window Command

Inserts a Distribution Window in the RISKview window

The Insert menu Distribution Window command (or clicking the Insert Distribution Window icon) inserts a distribution window in the RISKview window. Distribution windows can be used at any time to preview a probability distribution or results of fitting drawn curves.

A distribution window displays either a:

1) Graph of a theoretical distribution whose parameters are entered in the distribution window.

2) Graph of a distribution function generated by a fit of a drawn curve.

An overlay graph may also be placed on a distribution graph in the Distribution window. This overlay can come from any of the sources listed above.
The different elements of the Distribution Window are as follows:

- **Source.** Specifies the source of the distribution to be graphed, either **function**, **fit results** or **none**.
  1) **Function** specifies that distribution type and arguments are entered by the user directly in the window.
  2) **Fit Results** specifies that the distribution is from a fit result of a drawn curve.
  3) **None** removes any entered distribution. **None** typically is used to remove an overlay.

When source is set to **function**, the following items allow the entry of a distribution type and arguments:

- **Dist. and Arguments.** Selects a distribution type from all available distributions. Depending on the distribution type selected the displayed arguments will change. For distributions that take a set with a variable number of \( p \) or \( x,p \) values, a grid is displayed that allows entry of those values.

  Clicking the **Dist...** button displays the Distribution Palette with graphical images of all available probability distribution types. Clicking on the picture of a distribution selects it.

- **Tr. Min and Max.** Sets the minimum and maximum truncation limit for the entered distribution. When truncation values are entered, no values outside the truncation limits will have any probability of occurring.

Delimiters and Statistics are used to display underlying statistics on displayed distribution graphs:

- **Delimiters** (marked with inverted triangles). Allows setting of target probabilities and x-axis scaling using the mouse. Cumulative probabilities can be set directly on a distribution graph using the displayed probability delimiters. Dragging probability delimiters changes **left** and **right** \( x \) and \( p \) values shown in the probability bar below the graph and in the statistics grid. Dragging the delimiters at either end of the x-axis rescales the x-axis.

- **Statistics.** Displays the statistics for the graphed distributions, including any overlays. In addition, \( x \) and \( p \) values set using the delimiters in the statistics grid to the right of the distribution graph are also shown.
Icons in the Define Distribution Window

The following icons are available in the Define Distribution Window (as displayed left to right in the window):

- **Primary/Overlay Switch.** Switches the displayed graph and distribution information from the primary curve to the overlay curve.

- **Alternate Parameters.** Allows the selection of percentile parameters as arguments to the selected distribution.

- **Graph Formatting.** Displays the Graph Format dialog for changing type, scaling, style and titles for the displayed graph.

Alternate Parameters

Alternate Parameters allow you to specify values for specific percentile locations of an input distribution as opposed to the traditional arguments used by the distribution. The percentiles to be entered are specified in the Alternate Distribution Parameters dialog, displayed by clicking the ALT icon. Depending on the type of distribution being entered, the contents of the Alternate Distribution Parameters dialog will change.

Percentile parameters may be mixed with standard parameters by clicking the appropriate radio buttons. By selecting **Save as Default**, a set of percentile arguments may be set as the default for a given distribution type, so that every lognormal distribution, for example, will be entered in the Distribution window using a 10th and 90th percentile value.

Selecting **Descending Percentiles** specifies that the percentiles used for alternate parameters will be in terms of cumulative descending probabilities. Percentiles entered in this case specify the probability of a value greater than the entered argument x-value.
Graph Menu

Graph Format Command

Changes the type or appearance of the current graph

The Graph menu Format command changes the appearance of the selected graph. Use this command to change the type, scaling, style and titles of your graphs and turn delimiters on and off.

Save as Default

Clicking Save as Default sets the current format settings as the default. All new graphs generated will use these defaults.

Type Tab – Graph Format Command

Changes the type and format of a displayed graph

The Type tab on the Graph Settings dialog box allows you to change the type of a displayed graph.

- **Display As.** Displays a graph in density, cumulative ascending or cumulative descending format. **Auto** specifies that the type of graph displayed will be based on the type of input data entered. In this case, graphs will be displayed in density format except when the input data type is cumulative.
• **#Bins.** Sets the number of histogram intervals calculated across the range of a graph. The value entered must be in the range 1 to 200. The setting **Auto** calculates the best number of bins to use for your data according to Sturges' Rule, where $k$, the number of bins is found by:

$$ k = \left\lfloor 1 + \log_2 n \right\rfloor $$

• **Minimum.** Sets the minimum value where histogram bins start. **Auto** specifies that BestFit will start the histogram bins based on the minimum of the data graphed.

• **Maximum.** Sets the maximum value where histogram bins end. **Auto** specifies that BestFit will end the histogram bins based on the maximum of the data graphed.
Scaling Tab – Graph Format Command

Changes the scaling, units and axis tick marks on the active graph

The available Scaling options allow you to rescale the current graph, set the number of X and Y axis ticks, set the scale factor with which values are displayed and display gridlines on the graph. You can also select to have RISKview automatically scale the X and Y axis of a graph.

Note: X-axis scaling can also be changed by dragging the delimiters at the X-axis endpoints using the mouse directly on the graph.

- **Automatically Scale.** Specifies that RISKview will automatically calculate X or Y axis minimum and maximum values based on the range and probabilities of the data displayed in the graph.

  Note: Clicking the AutoScale button in the top right corner of a graph selects the Automatically Scale option and rescales the graph.

- **X-Axis Maximum.** Enters the X-axis maximum value for the current graph. This specifies the maximum value shown on the horizontal X-axis of the displayed graph. Values are entered in terms of actual values with all digits. Using the current scale factor, RISKview converts those values to the appropriate units (in thousands, in millions, etc.) for display. X-axis scaling may be adjusted to include all of a distribution or just a portion of it. This allows you to view only a piece of a distribution when more detail is desired.
• **X-Axis Minimum.** Enters the X-axis minimum value for the current graph. Information given for the X-maximum option also applies to X-minimum.

• **Y-Axis Maximum.** Enters the Y-axis maximum value for the current graph. This specifies the maximum probability value displayed on the Y-axis.

• **Y-Axis Minimum.** Enters the Y-axis minimum value for the current graph.

• **# of Ticks.** Defines the number of ticks drawn on the X-axis or Y-axis between the origin and the extreme values.

• **Scale Factor.** Sets the factor used in displaying units on the X- and Y-axis in RISKview graphs. Factors are entered as the listed unit names (thousands, millions, etc.) or as powers of 10.

• **Show Scale Factor Label.** Specifies that the scale factor will be labeled on the X and Y axes.

• **Show Grid Lines.** Specifies if Y or X-axis grid lines are to be displayed.

When RISKview initially scales a graph it calculates a default scale factor based on the magnitude of the values displayed in the graph. Entering a new scale factor causes the units displayed (i.e., in thousands, in millions, etc.) to change.
Style Tab – Graph Format Command

Changes the color, format and pattern of elements in the displayed graph

The Style tab in the Graph Format dialog box changes the colors, format and patterns on a displayed graph.

Style Tab in Graph Format Dialog Box

Foreground and Background Color

The Foreground and Background Color options set the color of the foreground and background elements in the displayed graph. Colors can be selected by clicking on the box to the right of the Color entry.

Curve Style

The Curve Style options change the color, format, pattern and other options of the current graph and its overlays. The Format, Pattern and Options available change with the type of the graph displayed.

The Format settings include:

- **Points Format.** Graphs unconnected points at each point on the density or cumulative curve.
- **Line Format.** Graphs cumulative line graph or density curve line graph.
- **Bars Format.** Graphs standard histogram bars.
- **Solid Format.** Graphs all curves with the area under the curve filled.

Pattern options include a variety of available line, point and fill patterns.

When an overlay is present, the Overlay entry displays the color, format, pattern and options for the overlay graph.
Titles Tab – Format Command

Allows the entry of custom titles for a graph

The Titles tab allows the entry of a custom title for the top of any graph, along with custom X- and Y-axis titles. Font style may also be set for titles.

- **Main Graph and Axis Titles.** Changes a selected title. Titles may also be formatted using any of the font styles listed in the dropdown font style entries.
- **Display.** Adds or removes the RISKview-generated labels on graphs - **Legend** (graphs with overlays only) and **Expected Value**.

Text and graphics may also be placed on graphs using the drawing and text editing capabilities of your spreadsheet. Using the RISKview Edit menu Copy command, the active graph can be transferred to the Clipboard where it can be pasted into your spreadsheet as a Windows Metafile. Once pasted, the graph can be resized and text and graphics may be attached to it.
Delimiters Tab – Graph Format Command

Selects the display mode for delimiters on a histogram graph or cumulative graph

Delimiters can be displayed on any graphs to allow 1) the setting of target probabilities directly on the graph and 2) X-axis rescaling. Delimiters are marked by inverted triangles at the top of a graph.

![Graph Format](image)

Delimiters can be turned on and off as desired and shading between delimiters can be displayed or removed. The color of delimiters and their associated shading can be specified by clicking on the box to the right of the Delimiter Color entry.

**Using Delimiters**

To move delimiters:

1) Click and drag any of the four delimiters marked by an upside-down triangle at the top of the graph to the desired location. When a comparison graph is displayed, moving probability delimiters also updates the **Left X, Left P, Right X, Right P, X(diff) and P(diff)** in the displayed Statistics tab. The **diff** statistics show the value and probabilities falling between the left and right probability delimiters. On a difference graph, delimiters update the **X, Y and difference** entries in displayed Statistics tab. For P-P and Q-Q graphs, moving the single delimiter updates the **Delimiter** entry in the displayed Statistics tab.
Graph in Excel Command

Draws the selected graph in Microsoft Excel in the spreadsheet's native format

The Graph menu Graph in Excel command places the selected graph data points in an Excel worksheet. Then, a native format graph is created on the worksheet from the data points.

Once the graph is created, it can be customized and rescaled using Excel's editing features. Please consult your spreadsheet's documentation for more information on editing the graphs.

For histograms, bar heights can be changed directly in Excel by changing the relevant series data.

Delimiter Defaults Command

Specifies the position of the left and right delimiters for all distribution graphs

The Graph menu Delimiter Defaults command specifies the starting delimiter positions for new distribution graphs. These settings affect all new distribution graphs.
Artist Menu

The Artist window is used to draw freeform curves that can be used to create probability distributions. The commands on the Artist menu control both how drawing is performed in the Artist window and how a probability distribution is created from a drawn curve. The Artist menu is only available when an Artist window is the active window.

Artist Window

![Artist Window](image)

**Drawing in the Artist Window**

After an Artist window has been inserted using the **Insert menu Artist Window** command, a curve may be drawn simply by dragging the mouse through the window. The following entries in the Artist window control the scaling and type of graph that is drawn:

- **X Min and X Max.** Specifies the X-axis scaling for the drawn graph.

- **# Markers.** Sets the number of markers that will be drawn as you drag across the min-max range of the graph. Markers allow you to drag the points on the curve to change its shape.

- **Curve Type.** Specifies the type of curve that will be created, where **Density** is a probability density curve, **Cumulative Asc.** is an ascending cumulative curve and **Cumulative Des.** is a descending cumulative curve.

- **Marker Drag Style.** Specifies whether markers will be connected with straight lines or curves when they are moved.
If you are drawing an ascending cumulative distribution (as specified in the Curve Type option), you will only be able to draw a curve with ascending Y values, and vice-versa for a descending cumulative curve.

When you have completed a curve, the end-points on your curve will be automatically plotted.

After drawing a curve, you may want to "drag" one of the markers to a new location. Simply click the left mouse button on the marker and, while holding down the button, drag the point to a new location. When you lift the button, the curve is redrawn automatically to include the new data point.

You can only move data points along the Y-axis, and you cannot drag points outside the axes. You cannot modify the positions of the end points.

**Clear Curve Command**

*Erases the curve in the active Artist window*

The Artist menu Clear Curve command erases the curve in the active Artist window.

**Smooth Curve Command**

*Smothes the curve in the active Artist window*

The Artist menu Smooth Curve command smoothes the curve in the active Artist window. Repeated selection of the Smooth Curve command makes a progressively smoother (and flatter) curve.
Create Distribution Command

Creates a General distribution from the drawn curve

The Artist menu Create Distribution command creates a General distribution from a drawn curve. A General distribution is a user-defined RISKview distribution that takes a minimum value, a maximum value and a set of X,P data points which define the distribution.

When the Artist menu Create Distribution command is selected, the General distribution created from a curve in an Artist window is displayed in a Distribution window.
Fit Curve Command

Fits a drawn curve to a probability distribution

The Artist menu Fit Curve command fits a probability distribution to a drawn curve. The results of the fit are displayed in a Fit Result window where each of the fitted distributions can be reviewed.

Fitted Distribution from a Curve in an Artist Window

Fit Results Window

When you fit a curve in a Distribution Artist window, a new Fit Result window is automatically created for you if one does not exist.
The contents of the Fit Results window are as follows:

**Fitted Distributions List**

The Fitted Distributions list displays all distributions for which valid fit results were generated. Clicking on a distribution listed in the Fitted Distributions list displays the fit results for that distribution, including graphs and statistics on the selected fit.

If a fit did not return valid results for a distribution type, that distribution is not listed in the Fitted Distributions list. The number of invalid fits is shown beneath the list.

**Rank By**

The Rank By entry ranks the distributions according to the RMS Error, or root mean squared error test, or Name, which simply lists fit results alphabetically. For more information on the RMS Error test, see Chapter 2: An Overview of RISKview.

**Fit Result Graphs**

For fit results in RISKview, Comparison and Difference graphs can be displayed.

For all graph types delimiters may be used to graphically set specific X-P values on the graph. X-axis minimum and maximum values may also be set by dragging the X-axis endpoint delimiters. Delimiters are marked by the inverted triangles above the graph.

**Comparison Graph**

Comparison Graph displays two curves - the input distribution and the distribution created by the best fit analysis.

Two delimiters are available for a Comparison graph. These delimiters set the Left X and Left P values, along with the Right X and Right P values. Values returned by the delimiters are displayed in both the probability bar under the graph and in the statistics grid to the right of the graph.
A Difference graph displays the difference between the input distribution and the distribution created by the best fit analysis.

A single delimiter can be used on the Difference graph to return specific X-Y values along with the difference between the input data and the fitted distribution at any X-value on the graph.

**Copy Command**

Copies data from the active Artist window to the clipboard

The Artist menu Copy command copies the selected data or the graph from the Artist window to the Clipboard. **All Points** copies all X and Y data points which define the drawn curve, including those calculated on lines connecting markers. **Marked Points** copies X and Y data points for markers only. **Graph** places a copy of the drawn graph in the clipboard.
Window Menu

Cascade Command, Tile Command

Arranges open windows and graphs in the RISKview Window

The Window menu Cascade and Tile commands cascade or tile the open windows neatly within the RISKview window.

List of Available Windows

Lists all open windows in the RISKview window

The bottom items in the Window menu list all open windows in the current tab in the RISKview window (the active window is noted with a check mark). To activate a window, select its name from the list.
Help Menu

**RISKview Help, Distributions Help**

Opens on-line help files for RISKview

The Help menu RISKview Help command opens the main help file for RISKview. All of RISKview's features and commands are described in this file.

The Help menu Distributions Help command opens the distribution help document for RISKview in .PDF format. Information on all of RISKview's distribution functions, including formulas, statistics and graphs, is included in this file.

**Online Manual**

Opens on-line manual for RISKview

The Help menu Online Manual command opens this manual on-line in PDF format. You must have Adobe Acrobat reader installed to view the online manual.

**Authorization Command**

Displays authorization information for RISKview and allows the authorization of trial versions

The Help menu Authorization command displays the Authorization dialog box, listing the version and authorization information for your copy of RISKview. Using this dialog box you can also convert a trial version of RISKview into an authorized copy.
About Command

Displays version and copyright information about RISKview

The Help menu About command displays the About dialog box, listing the version and copyright information for your copy of RISKview.
Appendix A: Using RISKview™ With Other DecisionTools™

Palisade's DecisionTools Suite is a complete set of decision analysis solutions for Microsoft Windows. With the introduction of DecisionTools, Palisade brings you a decision-making suite whose components combine to take full advantage of the power of your spreadsheet software.

The DecisionTools Suite

The DecisionTools Suite focuses on providing advanced tools for any decision, from risk analysis to sensitivity analysis to distribution fitting. Software packaged with the DecisionTools Suite includes:

- @RISK — risk analysis using Monte-Carlo simulation
- TopRank — sensitivity analysis
- BestFit — distribution fitting
- PrecisionTree — decision analysis with decision trees and influence diagrams
- RISKview™ — distribution viewing companion

Note: When you purchase the DecisionTools Suite, all the features of BestFit and RISKview come fully integrated into your copy of @RISK Professional that comes with the Suite.

While all the tools listed above can be purchased and used separately, they become more powerful when used together. Analyze historical and fit data for use in an @RISK model. Or use TopRank to determine which variables to define in your @RISK model.

This chapter explains many of the ways the components of the DecisionTools suite interact and how they will make your decision making easier and more effective.
Note: Palisade also offers a version of @RISK for Microsoft Project. @RISK for Project allows you to run risk analyses on project schedules created in Microsoft Project, the leading software package for project management. Contact Palisade for more information on this exciting implementation of @RISK!

Purchasing Information

All of the software mentioned here, including the DecisionTools Suite, can be purchased directly from Palisade Corporation. To place an order or receive more information, please contact the technical sales department at Palisade Corporation using one of the following methods:

- Telephone us at (800) 432-7475 (U.S. only) or (607) 277-8000 any weekday from 8:30 AM to 5:30 PM, EST
- Fax us at (607) 277-8001
- E-mail us at sales@palisade.com
- Mail us a letter at
  Technical Sales
  Palisade Corporation
  31 Decker Road
  Newfield, NY 14867

If you want to contact Palisade Europe:

- Telephone us at +44 (0) 1752 204310 (U.K)
- Fax us at +44 (0) 1752 894833 (U.K)
- E-mail us at sales@palisade-europe.com
- Mail us a letter at
  Palisade Europe
  The Blue House, Unit 1
  30 Calvin Street
  London E16 NW UK
Palisade’s DecisionTools Case Study

The Excelsior Electronics company currently makes desktop computers. They are working on a laptop computer, the Excelsior 5000, and want to know whether or not the company will profit from this venture. They built a spreadsheet model which spans the next two years, each column representing one month. The model takes into account production costs, marketing, shipping, price per unit, units sold, etc. The bottom line for each month is "Profit". Excelsior expects some initial setbacks on this venture, but as long as they are not too great and profits are up towards the end of two years, they will go ahead with the E5000.

Run TopRank First, Then @RISK

TopRank is used on the model to find the critical variables. The "Profit" cells are selected as outputs, and an automatic What-if analysis is run. The results quickly show there are five variables (out of many more) that have the most impact on profits: price per unit, marketing costs, build time, price of memory, and price of CPU chips. Excelsior decides to concentrate on these variables.
Next, Assess Probabilities

Distribution functions are needed to replace the five variables in the spreadsheet model. Normal distributions are used for price per unit and build time, based on internal decisions and information from Excelsior’s manufacturing division. At a marketing department meeting, @RISK’s Artist Window is used by managers to draw distribution curves which represent the range of possible marketing costs. Once a hand-drawn distribution is agreed upon, the **Fit Curve** command provides an @RISK distribution function for use in the model.

Add Distribution Fitting

Research is done to get weekly price quotes for memory and CPU’s over the past two years. This data is fed into @RISK’s distribution fitting and distributions are fitted to the data. Confidence level information confirms that the distributions are good fits, and the resulting @RISK distribution functions are pasted into the model.
Simulate with @RISK

Once all the @RISK functions are in place, the "Profit" cells are selected as outputs and a simulation is run. Overall, the results look promising. Although there will be losses initially, there is an 85% chance they will make an acceptable profit, and a 25% chance the venture will generate more revenue than they had initially assumed! The Excelsior 5000 project is given the go-ahead.

Decide with PrecisionTree

Excelsior Electronics had assumed they would sell and distribute the Excelsior 5000 themselves. However they could use various catalogs and computer warehouses to distribute their product. A decision tree model is built using PrecisionTree, taking into account unit prices, sales volume, and other critical factors for direct sales versus catalog sales. A Decision Analysis is run and PrecisionTree suggests using catalogs and warehouses. Excelsior Electronics puts that plan into full motion.
**Appendix B: Glossary**

**Definition of Key Terms**

| **Continuous Distribution** | A probability distribution where any value between the minimum and maximum is possible (has finite probability).  
|                            | See discrete distribution |
| **Cumulative Distribution** | A cumulative distribution, or a cumulative distribution function, is the set of points, each of which equals the integral of a probability distribution starting at the minimum value and ending at the associated value of the random variable.  
|                            | See cumulative frequency distribution, probability distribution |
| **Cumulative Frequency Distribution** | A cumulative distribution is constructed by cumulating the frequency (progressively adding bar heights) across the range of a frequency distribution. A cumulative distribution can be an “upwardly sloping” curve, where the distribution describes the probability of a value less than or equal to any variable value. Alternatively, the cumulative curve may be a "downwardly sloping" curve, where the distribution describes the probability of a value greater than or equal to any variable value.  
|                            | See cumulative distribution |
| **Discrete Distribution** | A probability distribution where only a finite number of discrete values are possible between the minimum and maximum.  
|                            | See continuous distribution |
| **Event** | The term event refers to an outcome or group of outcomes that might result from a given action. For example, if the action is the pitch of a baseball, the possible events might include a hit (with outcomes single, double, triple, home run), an out, a foul ball, a ball, etc. |
| **Expected Value** | See mean |
| **Frequency Distribution** | A frequency distribution is constructed from data by arranging values into classes and representing the frequency of occurrence in any class by the height of the bar. The frequency of occurrence corresponds to probability. |
Higher Moments

Higher moments are statistics of a probability distribution. The term generally refers to the skewness and kurtosis, the third and fourth moments, respectively. The first and second moments are the mean and the standard deviation, respectively. See skewness, kurtosis, mean, standard deviation.

Kurtosis

Kurtosis is a measure of the shape of a distribution. Kurtosis indicates how flat or peaked the distribution is. The higher the kurtosis value, the more peaked the distribution. See skewness.

Mean

The mean of a set of values is the sum of all the values in the set divided by the total number of values in the set. Synonym: expected value.

Most Likely Value

The most likely value or mode is the value that occurs most often in a set of values. In a histogram and a result distribution, it is the center value in the class or bar with the highest probability.

Percentile

A percentile is an increment of the values in a data set. Percentiles divide the data into 100 equal parts, each containing one percent of the total values. The 60th percentile, for example, is the value in the data set for which 60% of the values are below it and 40% are above.

Probability

Probability is a measure of how likely a value or event is to occur. It can be measured from simulation data as frequency by calculating the number of occurrences of the value or event divided by the total number of occurrences. This calculation returns a value between 0 and 1 which then can be converted to percentage by multiplying by 100. See frequency distribution, probability distribution.

Probability Distribution

A probability distribution or probability density function is the proper statistical term for a frequency distribution constructed from an infinitely large set of values where the class size is infinitesimally small. See frequency distribution.

Range

The range is the absolute difference between the maximum and minimum values in a set of values. The range is the simplest measure of the dispersion or "risk" of a distribution.

@RISK

@RISK (pronounced "at risk") is the name of the Excel Add-In for Risk Analysis described in this User's Guide.

Risk

The term risk refers to uncertainty or variability in the outcome of some event or decision. In many cases the range of possible outcomes can include some that are perceived as a loss or undesirable along with others that are perceived as a gain or desirable. The range of outcomes is often associated with levels of probability of occurrence.
**Simulation**  
Simulation is a technique whereby a model, such as an Excel worksheet, is calculated many times with different input values with the intent of getting a complete representation of all possible scenarios that might occur in an uncertain situation.

**Skewness**  
Skewness is a measure of the shape of a distribution. Skewness indicates the degree of asymmetry in a distribution. Skewed distributions have more values to one side of the peak or most likely value — one tail is much longer than the other. A skewness of 0 indicates a symmetric distribution, while a negative skewness means the distribution is skewed to the left. Positive skewness indicates a skew to the right.  
See kurtosis

**Standard Deviation**  
The standard deviation is a measure of how widely dispersed the values are in a distribution. Equals the square root of the variance.  
See variance

**Stochastic**  
Stochastic is a synonym for uncertain, risky.  
See risk, deterministic

**Subjective Risk**  
Subjective risk or subjective probability is a probability value or distribution determined by an individual's best estimate based on personal knowledge, expertise, and experience. New information often causes changes in such estimates. Reasonable individuals may disagree on such estimates.  
See objective risk

**Truncation**  
Truncation is the process by which a user chooses a minimum-maximum range for a random variable that differs from the range indicated by the distribution type of the variable. A truncated distribution has a smaller range than the untruncated distribution because the truncation minimum is greater than the distribution minimum and/or the truncation maximum is less than the distribution maximum.

**Uncertainty**  
See risk

**Variable**  
A variable is a basic model component that can take on more than one value. If the value that actually will occur is not known with certainty, the variable is considered uncertain. A variable, certain or uncertain, may be either dependent or independent.  
See dependent variable, independent variable
Variance

The variance is a measure of how widely dispersed the values are in a distribution, and thus is an indication of the "risk" of the distribution. It is calculated as the average of the squared deviations about the mean. The variance gives disproportionate weight to "outliers", values that are far away from the mean. The variance is the square of the standard deviation.
Appendix C: Recommended Readings

The RISKview User’s Guide has given you a start on understanding probability distributions. If you’re interested in finding out more about distributions and the theory behind them, here are some books and articles which examine various areas of interest concerning probability distributions.

Distribution Fitting

If you’re interested in finding out more about distribution fitting, consult any of these books:


Distribution Functions

To learn more about the distribution functions used by RISKview, refer to the following book:


* These titles can be purchased through Palisade Corporation. Call (800-432-7475 or 607-277-8000), fax (607-277-8001), or write to order or request further information on these and other titles relevant to risk analysis. The Palisade Technical Sales Department can also be reached by e-mail at sales@palisade.com or on the World Wide Web at http://www.palisade.com.
Index

@RISK ................................................................................................... 63, 65

A

About Command..................................................................................... 62
Alternate Parameters.............................................................................. 62
See Parameters, Alternate
Artist Window Command ...................................................................... 41
Authorization ...................................................................................... 7, 61
Authorization Command ........................................................................ 61

B

BestFit ............................................................................................... 63, 66

C

Cascade Command ............................................................................... 59
Clear Curve Command .......................................................................... 54
Copy Command .................................................................................... 39, 54
Create Distribution Command ............................................................. 55
Cut Command ....................................................................................... 39

D

DecisionTools Suite ........................................................................... 8, 63
Delimiter Defaults Command ............................................................... 52
Delimiters ........................................................................................... 52
See Graphs, Delimiters
Distribution Window Command ............................................................ 42
Distributions ....................................................................................... 15
Continuous ......................................................................................... 15
Creating .............................................................................................. 22
Creating from Artist Curve ................................................................. 55
Cumulative ......................................................................................... 16
Menus
  Artist Menu................................................................. 53
  Edit Menu ................................................................. 39
  File Menu ................................................................ 37
  Graph Menu .............................................................. 45
  Help Menu ............................................................... 61
  Insert Menu ............................................................ 41

New Command ............................................................. 37

Online Manual ............................................................... 61
Open Command ............................................................ 37
Overlays ........................................................................ See Graphs, Overlays

Palisade Corporation, Contact Information for .................. 5, 64
Parameters, Alternate ................................................... 44
Paste Command .......................................................... 39
Percentiles
  Calculating Targets .................................................. 25
  Cumulative Descending ............................................ 44
PrecisionTree .............................................................. 63, 67
Print Command .......................................................... 38
Project, RISKview ....................................................... 37

Recommended Readings ............................................... 73
Reports
  Copying ................................................................. 39
  Exporting .............................................................. 26
RVP File ........................................................................ 37, 38

Save As Command ....................................................... 38
Save Command .......................................................... 38
Smooth Curve Command ............................................. 54
Smoothing ........................................................................................................ 21, 54
Statistics .......................................................................................................... 25
System Requirements .................................................................................. 6

T

Targets .............................................................................................................. See Percentiles
Technical Support .......................................................................................... 4–6
Tile Command .................................................................................................. 59
Toolbars ............................................................................................................. 32
TopRank ............................................................................................................ 63, 65
Truncation ......................................................................................................... 43

U

Uninstalling RISKview .................................................................................. 8

W

Windows
  Arranging ....................................................................................................... 59
  Artist Window ................................................................................................. 20, 41, 53
  Distribution Window ...................................................................................... 42
  List of Available ............................................................................................ 59